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VNB ICD2

In Circuit Debugger/Programmer

Figure 1 VNB ICD 2

VNB ICD2 module is an all-in-one programmer/debugger tool connecting between the PC and the
designers target board, allowing direct in-circuit debugging and programming.

In addition to the educational/development board VNB EDU100, this is a must have development

tool for students as well as hobbyists to learn embedded programming or for professionals to
develop embedded application using Microchip’s PIC and dsPIC microcontrollers.

http://www.vnbtech.com
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The ICD2 is a complete In-Circuit Debugging and Programming. That means the ICD2 provides
ICSP (in-circuit serial programming) and at the same time can debug the target Microchip
microcontrollers that support debug mode.

The VNB ICD2 always works with the latest version of MPLAB IDE because the firmware can be
automatically updated with the new MPLAB IDE installation. MPLAB IDE is a free, integrated
Development Environment for development of applications using Microchip’s PIC and dsPIC
microcontrollers. MPLAB IDE and supporting documents could be downloaded from Microchip

Features

RS-232 interface to host PC

Real time debugging

Work with MPLAB IDE GUI (free from Microchip)
Firmware upgrade from PC, always work with latest MPLAB IDE
Power indicator LED

Busy LED

A push button to reset the board

A push button for external trigger event

Program configuration bits

Erase program memory with verification

Work the same way as MPLAB ICD2 at a much lower cost
Reading/Writing memory space

Reading/Writing EEDATA areas of the target MCU

Devices Supported

The VNB ICD2 supports most PIC and dsPIC Flash microcontrollers from Microchip. The latest
firmware for the ICD2 can be updated to add more supported devices. New firmware is available for
free download at Microchip. For the most current list of the supported parts, please refer to the
README file located in MPLAB IDE directory.
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User’s Guide

Since the VNB 1CD2 works the same way as the MPLAB ICD 2 from Microchip. Documents
related to the MPLAB ICD2, MPLAB ICD 2 in-Circuit Debugger User’s Guide, MPLAB ICD 2 In-
Circuit Debugger/Programmer and MPLAB ICD 2 Advisory can serve as good references for VNB
ICD2 users. Those documents are available for download here .

ICD2 user’s guide is also available from MPLAB IDE Help menu. To get there:
Help 2Topic... 2Select MPLAB ICD2 under Debuggers =>Click on OK.

&7 MPLAB ICD 2 Help

H ¢ =2 & 8 B

Hide Back Fomward Home  Print Help

Conlents |Index | Search | Favoles| ] -
= Qﬂ Operation Operatlon
w @ MPLAB ICD 2 Dverview

[+ @ [etting Started
& @ MPLAB ICD 2 Tutorial

& @ Addtional Topics o WMPLABICD 2 Overview
[+ @ ICD Function Summary i

= @ Troubleshooting A
[+ @ Troubleshooting Tips s MELARICD 2 Tutorial
@ Sl Test R,
[ @ FéQz/Common Problems o Additional Topics

& @ Enor Messages

& @ Waming Messages o |CD Function Surmmary

& @ Limitations

= @ Support
& @ Hardware Speciications B Mieroclip Technology Ine.
[ @ Customer Support Microchip 'Weh Zite
@ Mavigating in the Help Viewer v':'Fl:;f E::g; ;32?322
2] Glossary Mimochip Techmiral Spport

Figure 2: ICD 2 Help from MPLAB IDE

The following only serve as a quick guide in setting up and use the ICD 2. For more details on how
to use the MPLAB ICD, please refer the documents mentioned above.
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Communications port setup:

Make sure that the FIFO buffers are turned off and flow control is set for hardware in the
COMM driver dialog.

e Go to windows device manager.
e Double click on the communication Port you want to use (We use COML1 in this guide) to
bring up Communications Port (COML1) Properties

——acar,

5;3_ Device Manager

File  Action  View Help

-= W EHFS 2N & =RE

=2 GARFIELD
[+ k4 Blustooth Devices
¢ Computer
Elu Disk drives
Elg Display adapters
Lk DVD{CD-ROM drives
EI@ Floppy disk contrallers
EI& Floppy disk drives
Elﬁ Human Interface Devices
=Y IDE ATAJATART controllers
Elw kevboards
Ei-.i---r" Mice and other pointing devices
Elg Monitars
EIH Metwork, adapters
= Ports (COM & LPT)
5 r;g" Bluetooth Communications Part (COM3)
----- r;’f Communications Port (COML)
----- (y Comrmunicakions Port (COM2)
. 5 ECP Prinker Port (LPTL)
+- % Processors
-:.i---'@y Sound, video and game controllers

Figure 3 Windows Device Manager

e Click on Port Settings tab. Set Bits per second to 57600 or 19200
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Communications Port (COM1) Properties

| General| Fart Seftings | Driver || Details H Hesuurces|

Bits per second: | 57600 v
Data bits: |8 v |
Paiity: [None v

Stop bits: |1 v |

Flow contral: | None v |

[ Advanced... ] [ Restore Defaults ]

k. ]’_ Cancel ]

Figure 4 Communications Port Properties.

e Click on Advanced ... to bring up Advance Settings for COM1 and unselect “Use FIFO
buffers” (Fig. 5)
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Advanced Settings for COM1

[ ]Use FIFD bufers [requires 16550 compatible LART] o

Select lower zettings to corect connection problems.
Cancel

Select higher settings for faster performance.

Defaults

COM Port Mumber: | COM1 v|

Figure 5 Unselect FIFO buffers

MPLAB IDE Setup:

Dovice, Device Farily Download and install the latest MPLAB IDE
|P|o1a#srra Sim : 3 from Mlc_roc_hlg. Bring up MPLAB I_DE by
' ' ’ double clicking on the MPLAB IDE icon on
M Ot TR LR the desktop or select MPLAB IDE from the
Programrmers Start button. If you want to use CCS as the
@ PICSTARTPlus @ MPLABICDZ @ FICHt2 compiler tool inside MPLAB, MPLAB IDE
@ PROMATEl @ PICK1 Plug-In is to be installed. The Plug-in can be
@ WPLAB PM3 @ MPLAB REALICE downloaded from CCS
Language and Design Tools .
o o e & D From the MPLAB IDE 'I_'ool Bar, click on
¥3 80 Configure = Select Device...
Bekiignere To work with the VNB educational board
@ MPLAB SIM @y MPLABICD 2 @ PICkitz [(JII:(iaaszselect PIC16F877A
@ HMPLAB REALICE g- )
MPLAB ICE 2000 MPLAB ICE 4000 Note that ICD2 is supported as both debugger
PCMI B ‘ @ Mo Module ‘ and programmer.
Please refer to MPLAB IDE User’s guide for
more details. The user’s guide can also be
[ ok | [ cancel | [ Hew | downloaded from Microchip

Figure 6: Select Device
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Project Wizard:

e Project->Project wizard

e Click Next on the welcome! Screen

e Select your target PIC MCU, in our case PIC16F877A

e Click Next to see a screen to select a language tool suite: we’ll select CCS C Compiler for
P1C12/14/16/18. Please note that there are other compilers that are supported by MPLAB
IDE as seen in the pull down list on Fig. 7

e Click Next after select CCS Compiler and specify the location of the compiler by clicking on
Browse... button.

e Specify project name and Directory then click Next

e Adding file to project or just skip and add later.

e Click Next, Finish and Done with project Wizard setup

Project Wizard

Step Two:
Select a language toolsuite

Active Toalzuite; lccsC Compiler for PICT2/A14/16/18 W

B Knudsen Data CCE

Toolzuite Contentz (B Krudzen Data CCBE

[ CCS C Compils BoostC C Cornpiler for PICTE
SRS B oostC C Compiler for PICT8
BoostC++ CAC++ Compiler for FICTE
BoostC++ CAC++ Campiler far FICT18
Byte Craft Agzembler & C Compiler

: CCS C Compiler for PICT 241 4/16/18
S 4R PICT8

Ii;-":F'-mgram Files\FA{ 18R Systems Midiange
icrochip MPASK Toolzuite

Help! My Suite lsn't Listed! ] [ ] 5how all installed toolsuites

’ < Back ” Mt = ][ Cancel ][ Help

Figure 7: Project Compiler/language Tool Suite Selection
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Project Wizard

Step Three:
Marme vour project

Project Mame

| by b aaic Project |

Project Directary

|E:'\Dncuments and SettingshCOMD ezkiopt M PLAEB Wy Project | [ Browse. ..

[ < Back ][ Mest > ] [ Cancel ] [ Help ]

Figure 8: Project Name and Directory

Step Four:

B
Add any existing files to pour project %jéo:}

[

myE 1 4. cof ez[2]vmuE 4_uzePortE .o
myE14d.emn

myE14. HE=

myET14.L5T
& Remowve
N

myE14.sta

myE 4. BAK,

myE4d.c
myEd_uzeFortE $3%
myE4_uzeFortE BAE £ | »

mij_useEmtE.c f i Check. the baox to copy the file to the
L uzeParte.co —= project directary. Click the filename ta
| > edit the name of the local copy.

i ) ) ) ) ) ) )

< Back ][ Mewt » ][ Cancel ] [ Help

Figure 9: Add File to Project.
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e After exiting the wizard, the MPLAB IDE desktop will again be visible. Close all other
windows on the desktop to see the Project window.

e Double click on the source code file under Source Files to see the code. Note : for CCS
compiler, the include files are not added to the project but they are being used.

e The project now can be compiled etc...
ICD 2 setup now can be carried out before any programming or debugging can be done.

» My Magic Project - MPLAB IDE v7.50

File Edit “iew Project Debugoger  Programmer Tools  Configure Window  Help

J Checksum: 0x0f02

B My Magic Project.mow |:||E| El

=l |:I MMy Magic Project.mcp
EII:I Source Files
: e mwE4_usePortE.c
[Z3 Header Files
(3 other Files

[ Files | ¥ Symbols

PIC16F37 74

Figure 10: Project Window
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Setup ICD2 as Programmer:

Power up the ICD2
Connect RS232 cable from PC to the ICD2
Connect the ICD2 to the target (VNB Educational Board).
Power up the target board (VNB Educational Board)
The ICD2 could be connected as a programmer
o0 From the tool bar, click on Programmer ->Select Programmer ->pull right to select
MPLAB ICD 2.
Programmer 2MPLAB ICD2 Setup Wizard...
Click Next on the Welcome! Screen
Select COM1 (in this guide), as Com. Port.
Select Baud Rate as 57600,then click Next

O O0OO0o

MPLAB ICD 2 Setup Wizard

Communications
Select a communications method.

Corm Port Baud Rate

G ~| (550 v

[ ¢ Back " Mest » ][ Cancel ] [ Help

Figure 11: Communication Port and Baud Rate

0 Select “Target has own power supply” then click Next
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MPLAB ICD 2 Setup Wizard

Power

Selectt t Eﬁ
elect target power source. /
2%

()T arget haz own power suppl
() Power target from the MPLAE ICD 2

Hate: [ pou wish to power your application from the MPLAB ICD 2, then the MPLAR ICD 2
muzt be powered with an independent power supply. [MPLAB ICD 2 can not draw enough
poer from the JSE cable to program the target. ]

See the MPLAR ICD 2 Users Manual for maore details.

l < Back ” Meut > l[ Cancel ] [ Help

Figure 12 Target Power supply

0 Make sure MPLAB automatically connects to MPLAB ICD2 is unselected.

MPLAB ICD 2 Setup Wizard

Connection

Enable auto-connection. /
o3

Wiould pou like MPLAE IDE to automatically connect ta the MPLAB ICD 2 on start up?
If enabled, MPLAE IDE conveniently connects to the MPLAR ICD 2 at project startup.

If dizabled, MPLAR IDE waits until the user initiates a connect operation before attenpling
to comnunicate with the MPLAE ICD 2.

Maote: The potential downzide to enabling auto connection is that MPLAB IDE will always
attempt to communicate with the MPLAEB [CD 2 on project startup. [F there iz a device
other than the MPLAE ICD 2 on the selected communications channel it might be
damaged by this attempted communication,

[ MPLAE IDE automatically connects to the MPLAE ICD 2

l < Back “ Meut » Jl Cancel l[ Help

Figure 13: Auto Connection option
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0 Enable “ICD2 automatically downloads the required operating system”” then click on
Finish in the next screen to complete the ICD2 setup wizard.

L

Download

B
Enable auto-download of operating systems. %/':;.:3}

Would you like MPLAB IDE to automatically dovenload [without prompting] MPLAE CD 2
aperating zpztemns when needed?

The MPLAB ICD 2 uses different operating systems for different target families.

If enabled, MPLAE ICD 2 will autornatically download the appropriate operating system
whenever it detects that the aperating system curently residing within the MPLAR ICD 2 is
hiot the correct one for the selected target device, or whenever MPLAB IDE detects a
newer yerzion of the operating system on the users computer.

If dizabled, MPLAE ICD 2 will prompt the uszer for permiszion to download befare actually
downloading.

MPLAR ICD 2 automatically downloads the required operating aystem

[ < Back ” Mext = ][ Cancel ][ Help ]

Figure 14: Auto download operating system

o Now it’s time to connect the ICD2 as a Programmer: Programmer ->Connect
(Fig. 15)
e Compile project and program the target.

o Project>Compile (Fig. 16)

0 Programmer Settings *Program Tab (Fig 17): Select “*Manually select memories
and ranges. Click on Full Range” under Program Memory.

0 Programmer 2>Program

The proprietary information is and remains the property of VNB Technologies.
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B Output |’—_| |EI ril
|| Build || “ersion Contral || Find in Files | MPL&E ICD 2|

Auto-connect not enabled - MNot connecting (T enabling auto-cor (|
IO arnl0349: Flease ensure that wour swstem's sarial FIFOD buffe)
Connecting to MFELAE 1”0 2

Connected

Setting »dd source to target

Target Dewice FICT BFS? 74 found., rewision = Resw Ox8
FReading 12D Froduct 1T

Funning IO Self Test

Fassed
FMFLAEBE 1D 2 Readss

A
¥

Figure 15: Connect ICD2 as programmer

| Build | %ersion Control | Find in Files | MPLAB ICD 2|

Clean: Deleting intermediary and output files. ~
Clean: Deleted file "CADocuments and Settingsh\COVDeskiophhdFL
Clean: Daone.
Executing: "ChFrogram Fileg\FICC\Cosc.exe"” "myEd.c" +Fhd +DF -
>>»»Warning 208 "CAProgram Files\FICO\Examples(@iutility.c" Lin
»>>Warning 206 "ChAProgram Files\FICO\Examples(@hutility.c" Lin
»»> WWarning 208 "ChProgram Files\FPICC\Examples(2ihmyE 4 " Li
>»> Wvaming 203 "ChFrogram Files\FICC\Examples(2ymyE4d.c" Li
Memory usage: ROM=1% RaAk=3%5-3%
U Errars. 4WWarnings,
Loaded ChFrogram Files\FICC\Examples{ZhmyE 4. cof.
BUILD SUCCEEDED: Fri Jan 26 17:33:13 2007

>

Figure 16: Compile Project
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MPLAB ICD 2 Settings

| Status | Communication | Limitations | F'u:uwer| Program | Wersions | \wamings |

() Allow ICD 2 to zelect memories and ranges

(*) Manually select memaries and ranges

M ermones Prograrm O phions
Prograr Freeze on Halt
Canfiquratian Eraze all befare Program
[ ]EEFPROM [ ] Preserve EEPROM on Program
C]ID
E sternal
Program Memory E=ternal Memory
[hex)
Start | 0=
End |O=1FFF End |[0=

Full Range Full Hange

Boatloader

T Ey A b A g o
| JL I Sy o Y L gL
| ; & L DO,

Autarmatically

[ ] Program after successful build

[ ] Run after successful program

| aF. I | Cancel Apply | Help

Figure 17: Program Settings
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B Qutput

| Build | “ersion Contral | Find in Files | MPLAB ICD 2

Lyerty Succeede b
Frogramming Configuration Bits

.. Config kMemaory

weribving configuration memaony...

Jenfy Succeeded

..Frogramming succeeded

Zh-Jan-2007, 17:3b:5¢

bMFLAE ICD 2 Ready
Frogramming Target...
Jyalidating configuration fields
..Erasing FPan

.Frogramming Fragram bdemary (Oxl - 0x1FFF)
Wearihving...

..Frogram kMemary

yerfy Succeeded
Frogramming Configuration Bits
.. Config kMemaory

weribving configuration memaony...
yenfy Succeeded
..Frogramming succeeded
Zh-Jan-2007. 17:50:31

tFPLAER ICD 2 Feady

&

< |

f:igure 18: Programming the target

The proprietary information is and remains the property of VNB Technologies.
The receiving Party does not receive any right or license under copyrights, patents, trade secrets without the agreement of VNB Technologies.

VNB Technologies Inc. www.vnbtech.com




VNB ICD2 Manual 16

Setup 1CD2 as Debugger:

Step to setup the ICD 2 as a debugger is very similar to those of the programmer: Instead of start out
with Programmer from the Tool Bar, start out with Debugger in the tool bar:
e The ICD2 could be connected as a debugger:
o0 From the tool bar, click on Debugger ->Select Tool 2pull right to select MPLAB
ICD2
0 Debugger 2I1CD2 Setup Wizard...
0 Debugger >Connect
e Debugger—>Settings
o Select “manually select memories and ranges”
o Click on “Full Range”

e Enter Debug Executive mode: program code must be programmed into the target PIC micro
MCU to use the in-circuit debugging capabilities of the ICD 2.
o Debugger 2Program
o0 If the program code is not loaded, you would get error message like the one seen
here, ICD0083 (Fig. 19)

M Qutput

MPLAB ICD 2 Ready

MPLAB ICD 2 Ready

ICDWarn0015: Frogram memory has changed since last program operation? Continue with Debug operation?
Stepping Target

ICD0083: Debug: Unable to enter debug mode. Flease double click this message for maore information.
MPLAB ICD 2 Ready

Programming Target...

LWalidating configuration fields

..Erasing Fart

...Programming Program kemory (0x0 - 0x1EFF)
..Loading DebugExecutive

..Programming DebugExecutive
...Frogramming Debug Yectar

“erifying...

...FProgram kemory

...Debug Executive

..Debug Yectar

LNerfy Succeeded

Frogramming Configuration Bits

.. Config Memory

“Werifying configuration memary. .

WNerify Succeeded

Connecting to debug executive

..Frogramming succeeded

28-Jan-2007, 16:43:.02

MPLAB ICD 2 Ready
Stepping Target
MPLAB ICD 2 Ready
Stepping Target
MPLAB ICD 2 Ready

Figure 19: MPLAB ICD2 program loading for entering debug mode
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The ICD 2 executes in Real-Time or in Step mode (Fig. 20):
o Real time execution occurs when the target PIC MCU (PIC16F877A in the VNB Educational
board in our case) is put in the MPLAB IDE Run mode.
e Step mode execution can be accessed after the processor is halted.

™ Exp4 PortE - MPLAB IDE v7.50 - BIx]

File Edit view Projeck Debugger Programmer Tools  Configure  window  Help

CDE | e | [ S P | Release v w B @ | ? 4

i Checksum: 0x2cd7 || p mipp & O || OxOp By @
!nmﬂeﬂﬁ‘m%_EUElEJ Bl C:\Program Files\PICCAExamples{2)\myE4_usePortE.c |L||E||Z| B
Exp< PortE.
= D RO ER typedef enwm [GREEN,YELLOW,LED} colors:
=1 Source Files
H - -- myE4_usePortE.c woid main()
(=1- [0 Header Files {
- [B] 1efaFTah
[ other Files ile (TETE) |
light one_led(GREEN) :
wait_for_one_pressi);
delay_ms (1000 ;
light one_led (YELLOW) ;
| [ Files |¢l§ Symbals |
| wait_for_one_pressi)
delay m=s (1000 ;7

£

MPLAE ICD 2 PIC16FS77A pC:0x56 bank 0  Ln 26, Col 1 INS | WR.

Figure 20: Debug Mode

e Here is a table of commonly used ‘Debugaer Mems  Toolbar Buttons
debug operations from the toolbar. o ]
Please refer to MPLAB IDE Help for
more details. Hat

Animate

Step Into @

Step Cwer

Figure 21: Commonly used debug operations et
Reset .
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Connector/Jack Description:

CN1: 9V DC Jack
CN2: RS232 Connector
CN3: ICD Connector.

Pin Number 1 2 3 4 5 6
ICD 2 Board | VPP VDD GND |PGMCLK | PGM Data | N/C
Target Board | MACLR |VDD+5V | GND | B7 B6 B3
Part List
To make it easier for those who chose to assemble the board themselves, the part list is included
here
Description Designator Quantity | Notes
Capacitor 0805 15pF C1,C2 2
CAP POL Electrolytic CAP C3,C12,C13 3
47uF
Cap 0805 0.1uF C4,C5,C6 3
CAP POL 1206 TANT C7. C8.C9.C10,C11 5
10uF
DC Jack CN1 1
DB9 Female Connector CN2 1
Header, 3-Pin, Dual row CN3 1
Diode 1N4148 D1,D2,03,D4,D5,D6,D7 7
LED1 is Red, LED2 is
LED LEDL, LED2 p | YELLOW for power
indicator and busy
indicator
NPN General Purpose
Amplifier 2N3904 QLQ2 2
PNP General Purpose
Amplifier 2N3906 Q3,04 2
Resistor 0805 330 Ohms R1,R2,R3,R4,R5,R6 6
Resistor 0805 1K R7 1
Resistor 0805 4.7K 1% R8,R9 2
Resistor 100K 0805 R10 1
Resistor 0805 47K R11 1
Resistor 6.8K 0805 R12,R13 2
Resistor 2.2K 0805 R14,R15 2

The proprietary information is and remains the property of VNB Technologies.
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Resistor 0805 22K R16,R17 2
Resistor 0805 10K R18,R19 2
Voltage Regulator (Convert

12V To 5.0V), 3-pin Ul 1
LM7805

PIC16F877A-40PDIP U2 1
MAX232 U3 1
Oscillator 20MHz Y1 1

000C

Ol
o
(&)
(®)
n.

Figure 22: ICD 2 PCB

ICD2 boot-loader and downloading OS system
(This only applies to those who chose to assemble their own 1CD2 board)

The PIC16F877A needs to be first flashed with the ICD2 bootloader file which can be downloaded
from www.vnbtech.com. You might not have to worry about this step because the PIC is shipped
with the bootloader preloaded.

Before the ICD 2 could be used, you need to update it with the latest Operating System.
e Programmer/Debugger *Download ICD2 Operating System.
o Select the latest OS which is the hex file in C:/Program Files/Microchip/MPLAB ICD2/

The proprietary information is and remains the property of VNB Technologies.
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You would not be able to connect the ICD2 if the PIC16F877A is flashed with the bootloader and
the OS is not downloaded:
e An attempt to connect the ICD 2 before downloading the OS will result in error messages
ICD0286 and ICD0021.
e After the OS downloading, ICD2 connection is a success.
If you bought a fully assembled version, you would not have to worry about these steps.

PLLAB ID | Ll
File Edt ‘iew Project Debugger Tools Configure  Window  Help

J (@ | ‘i | ) _ 2t Pogranme 278 %) J Checksum: OxOfct ‘ L3O Ba B/ B30y F | g
MPLAB ICD 2 Setup Wizard.,..

J T Aag

Pragram B Output
Read

Werify

Erase Part
Blank Check
Read EEFROM

Buld | Version Cartial | Findin Fi|es| MPLABICD 2

ICD0021: Unahle to connectwih MPLAB ICD 2
MPLAB ICD 2 Ready
Connecting to MPLAB ICD 2
ICOM/am0054: MPLAR IDE has lost communications with the MPLAB ICD 2. Would you
Release from Reset |m Unahle to communicate with ICD
Hold i Reset D021 Unakle to connect with MPLAB ICD 2
MPLAB ICD £ Ready
Apart Operation Downloading Operating System
Connecting to MPLABICD 2
..Connected
. Setting Vdd source to target
Settings... Target Device PICTBFE?7A found, revision = Rev 048
[rTm— .Reading ICO Product ID
BLE Symbols‘ Funning I%D Self Test
' Passed
.Download Operating System Succeeded
MPLAB ICD 2 Ready

¢

Connect

MPLABICDZ  PICL6FE77A 0 2dec bank 0
Figure 23: Before First Connection, Need to Download OS

Requirements:

Power Supply
Require a 5-12V DC power supply adapter.

System Requirements:
e Windows 95, 98, ME, NT, 2000 or XP
e RS232 port and USB port.
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Quick Tips:

To avoid any potential complications/errors when using the ICD2, please follow the Power Up and
Power Down Sequences below:

e Power Up Sequence:

(0]

O O0O0O0O0O0

Power up The ICD first > Connect ICD2 to the Target Board using the ICD 2 cable
Launch MPLAB IDE

Open Saved Workspace or Create New project

If 1CD 2 was not setup, set it up as programmer/debugger

Power up the target board (Educational board in our case)

Connect RS232 cable

Debugger/Programmer—->Connect

e Power Down Sequence:

o

O O0OO0OoOo

DO NOT disconnect the ICD cable first.
Disconnect the target board power
Disconnect the RS232 cable

Disconnect the Power Supply of the ICD2
Disconnect the ICD2 cable

e After loading the program code, if you don’t see the green arrow, click Reset Icon.

e When you Step Over a line like while(input(PUSH_BUTTON)), the debug cursor (Green
Cursor) might seems to stuck here forever, make the condition of the while statement a
FALSE one (press the event push button on the educational board) so that the cursor will go
to the next line when click on the Step Over Icon in debug. (Fig.24)

e To save time in setting up the ICD2 and other settings when you resume your work next
time, before leaving current working session, save working space: File = Save Workspace or
File »Save Workspace as. This saved work spaces can be opened next time you launch
MPLAB IDE: File 2Open Work Space (Fig. 25)
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# Exp4 PortE - MPLAB IDE v7.50
File Edit ‘iew Project Debugger Programmer Tools Configure  Window Help

DEH| B GRS ? RV s HDBO 78

J Checksum; 0x2c47 ‘ PUBBTOER ‘ oo 0o B

s — olx B
: :\Program Files\PICC\Examples(2)\myE4_usePortE.c [._|[E|[§J I “_” |
=N T $define YELLOW LED PIN_EL =
fdefine RED LED PIN ED = A
§define PUSH BUTTON PIN ES
finclude <utility. o>
I C:\Program Files\PICCYExamples{2)tutility.c
typedef emm |GREZN, Y] waihclow pne preost) ~
while | input (PUSH_BUTTON) ) - -
- By| | while!!input (FUSH_EUTTON));
void main() 5
4
{
show binary on leds (int n) |
vihile (TRUE) | output_h:l.ghtGREEN_LEDj;
output_high (YELLOW_LED) ;
output_high (RED_LED) ; b |
if (bit_testin,0))
D output_low(GREEN LED) ;
Light_one_led|GREEN Tl ity e R
i output_low (YTELLOW_LED) ;
2 if (bit testin,Z))
wait_for_one_press| i _t Low(RED LED)
delay ms(1000) ; } PR LR S 2
light_one_lethELLD
light one lediint led) {
Step ; v/
I >
Stepl = =
MPLAB ICD 2 Ready L
Stepping Target E
MPLAE ICD ¢ Ready )| (-
e !
4 1 . | l

MPLA ICD 2 PICLEFET7A P30 0 ZDhCe bank 0 Ln3, Col { INS | WR,
Figure 24: While Loop Line: Debug Step Over

e Step Over a line like delay_ms(10) would seem to take forever, click on the Pause icon to get
over to the next line.
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w Expd PortE - MPLAB IDE v7.50

Fle Edt Miew Project Debugger Programmer Tools Configuee  Window Help

|DEW| mE SAB? [Recasevi G HBO| 78

J Checksum: 02978 | o 1000 B T (0 B J O304 By g

M Expd PortEmew (- [0 ]

=] @ Exp4 PortE.mcp

El (1 Soures Fles
mivE4_usePortE.c
: (1 Header Fies

B Qutput

Build || Yersion Cantral | Fi

Auto-connect not enabl

LEFETTA Connecting to MPLAB |

(1 Other Fles Comnected
Setting Vdd source tots
arcemt Clowatoe O LE S

finclude <16£3774.h=
fdevice ICD=TRUE
f#fuses HE, NOLVE,NOWDT, BUT

fuse delay (clock=E0000000)

#define GREEN LED PIN EZ
fdefine YELLOW LED PIN El
#define RED LED PIN_EO

M C:\Program Files\PICC\Examples(2)\myE4_usePortE.c

Save Workspace As |1”£|
Savein | [ My Project V-‘ @ L, £ M-
3 4 porte
{ ICD2 Example olors;
My Recent Simp\e Example
Documents | 1 Testing
@ Lo urtitied
[esktop
L
I &
by Documents k]
My Carmputer
File: nare: V| L Save J
My Metwark  Save as type: |MPL~'3«B Wwiorkspace Files [*.mew)] .V_| [ Cancel ]
& I | &
IMPLAB D2 PICLGFE77A pcl zdic bankd Lni, Coll NS WR ,:EI

Figure 25: Save work space
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Contact information:

Visit our company website http://www.vnbtech.com

In Vietnam, please contact our local VNBTECH members:
e Mr. Nguyen Vinh Truong @ 0908444793
e Mr. Phan Tan Dat @ 0903151886
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